Copyright

Copyright © 2005 BEA Systems, Inc. All Rights Reserved.

Restricted Rights Legend

This software and documentation is subject to and made available only pursuant to the terms of the BEA Systems License Agreement and may be used or copied only in accordance with the terms of that agreement. It is against the law to copy the software except as specifically allowed in the agreement. This document may not, in whole or in part, be copied, photocopied, reproduced, translated, or reduced to any electronic medium or machine readable form without prior consent, in writing, from BEA Systems, Inc.

Use, duplication or disclosure by the U.S. Government is subject to restrictions set forth in the BEA Systems License Agreement and in subparagraph (c)(1) of the Commercial Computer Software-Restricted Rights Clause at FAR 52.227-19; subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013, subparagraph (d) of the Commercial Computer Software--Licensing clause at NASA FAR supplement 16-52.227-86; or their equivalent.

Information in this document is subject to change without notice and does not represent a commitment on the part of BEA Systems. THE SOFTWARE AND DOCUMENTATION ARE PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. FURTHER, BEA Systems DOES NOT WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING THE USE, OR THE RESULTS OF THE USE, OF THE SOFTWARE OR WRITTEN MATERIAL IN TERMS OF CORRECTNESS, ACCURACY, RELIABILITY, OR OTHERWISE.

Trademarks or Service Marks


All other trademarks are the property of their respective companies.
Contents

1. Introduction
   Overview of the Domain Template Builder ................................................. 1-1
   About Domain and Extension Templates ................................................. 1-3
   Overview of Creating Domain Templates Using the Domain Template Builder .... 1-3
   Overview of Creating Extension Templates Using the Domain Template Builder ... 1-5
   Additional Tools for Creating Templates and Domains .............................. 1-7

2. Starting the WebLogic Domain Template Builder
   Starting the Domain Template Builder on Windows Platforms ..................... 2-1
   Starting the Domain Template Builder on UNIX Platforms ........................ 2-2

3. Creating Domain Templates Using the Domain Template Builder
   Create a New Template ................................................................................. 3-2
   Select a Template Domain Source ............................................................. 3-2
   Describe the Template ............................................................................... 3-3
   Add or Omit Applications .......................................................................... 3-4
   Add Files .................................................................................................... 3-6
   Add SQL Scripts .......................................................................................... 3-7
   Configure the Administration Server ......................................................... 3-9
      Specifying Listen Addresses .................................................................... 3-12
      Specifying Listen Ports ........................................................................... 3-13
   Configure an Administrator Username and Password .............................. 3-13
Configure Users, Groups, and Global Roles ........................................... 3-14
Assign Users to Groups ................................................................. 3-17
Assign Groups to Groups ............................................................. 3-17
Assign Users and Groups to Global Roles ..................................... 3-18
Specify Start Menu Entries .......................................................... 3-19
Prepare Scripts and Files with Replacement Variables .................. 3-20
    Replacement Variable Definitions ............................................. 3-22
Review the Domain Template ...................................................... 3-23
Create Your Domain Template ..................................................... 3-24

4. Creating Extension Templates Using the Domain Template Builder

    Create a New Extension Template ............................................. 4-2
    Select a Template Domain Source for Your Extension Template .... 4-2
    Describe Your Extension Template .......................................... 4-3
    Add or Omit Applications in Your Extension Template ............... 4-3
    Add Files to Your Extension Template .................................... 4-4
    Add SQL Scripts to Your Extension Template ............................ 4-5
    Configuring Security Options in Your Extension Template .......... 4-5
    Prepare Scripts and Files When Creating Extension Templates .... 4-7
    Review the Extension Template Settings ................................. 4-7
    Create Your Extension Template ............................................. 4-7

5. How Do I . . . ?

    How Do I: Create a Custom Domain Template? ......................... 5-1
    How Do I: Create a Custom Extension Template? ....................... 5-7
Introduction

This section provides an overview of how to create templates using the Domain Template Builder.

Topics include:

- Overview of the Domain Template Builder
- About Domain and Extension Templates
- Overview of Creating Domain Templates Using the Domain Template Builder
- Overview of Creating Extension Templates Using the Domain Template Builder
- Additional Tools for Creating Templates and Domains

Overview of the Domain Template Builder

One method of creating domains in WebLogic Server is to use domain and extension templates that contain the main attributes and files required for building or extending a domain. To simplify the process of creating templates, BEA provides the Domain Template Builder, a stand-alone Java application that guides you through the process of creating custom domain and extension templates. This process is illustrated in Figure 1-1.
The Domain Template Builder is designed to be used off-line, in graphical mode only. It is not supported in console mode. Therefore, the console attached to the machine on which you are using the Domain Template Builder must support a Java-based GUI. All consoles for Windows systems support Java-based GUIs; only a subset of UNIX-based consoles support Java-based GUIs.

BEA delivers a set of predefined domain and extension templates with your product installation that you can use to create domains. This set of templates includes the base WebLogic Server domain template, and various extension templates that allow you to add product component functionality and samples to the base domain. For more information about the templates provided by BEA, see Domain Template Reference at the following URL:

http://e-docs.bea.com/common/docs90/tempref/index.html

After you create your domain and add new resources and applications to it, you can use the Domain Template Builder to create a custom domain template. You can also use the Domain Template Builder to customize an existing template. For example, you may want to remove applications or add SQL scripts for additional databases. To do so, select the existing domain or template as the source for your new custom template. When your custom domain templates are complete, you can start using them to create domains using the Configuration Wizard, WLST.
Offline, or the unpack command. For more information about these tools, see “Additional Tools for Creating Templates and Domains” on page 1-7.

About Domain and Extension Templates

When you are using the Domain Template Builder, the term template refers to a Java Archive (JAR) file that contains the files and scripts required to create or extend a domain. With the Domain Template Builder, you can create the following types of templates:

- **Domain template**—defines the full set of resources within a domain, including infrastructure components, applications, services, security options, and general environment and operating system parameters. You can create a domain template from an existing template or from a domain. A domain template is used to create a new domain.

  As part of your product distribution, BEA provides a Base WebLogic Server domain template. This template defines the core set of resources within a domain, including an Administration Server and basic configuration information, infrastructure components, and general environment and operating system options. It does not include sample applications. You use this template to create a basic WebLogic Server domain that you can then extend using an extension template that contains applications and services, or additional product component functionality.

- **Extension template**—defines applications and services that can provide additional product component functionality, such as Apache Beehive, product sample applications, or JDBC or JMS components. This type of template can be used to extend an existing domain.

Overview of Creating Domain Templates Using the Domain Template Builder

To create a custom domain template using the Domain Template Builder, select the domain or domain template from which you want to create your new domain template. You then have the option of modifying the following:

- Basic template information
- Application and domain directory contents
- SQL scripts for database configuration
- Administration Server and user configuration
- Basic security configuration, such as creating users, groups, and global roles and their assignments
Start menu entries (Windows systems only)

Customized scripts and variables

Table 1-1 summarizes the steps necessary to create a domain template using the Domain Template Builder.

Table 1-1  Steps for Creating a Domain Template Using the Domain Template Builder

<table>
<thead>
<tr>
<th>In this step . . .</th>
<th>You . . .</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a New Template</td>
<td>Choose Create a Domain Template to create a new domain template.</td>
</tr>
<tr>
<td>Select a Template Domain Source</td>
<td>Select the domain template or the directory of the domain from which you want to create a new domain template.</td>
</tr>
<tr>
<td>Describe the Template</td>
<td>Specify a description of the template.</td>
</tr>
<tr>
<td>Add or Omit Applications</td>
<td>Review and modify, if desired, the list of applications to be included in the template.</td>
</tr>
<tr>
<td>Add Files</td>
<td>Review and modify, if desired, the files to be included in the template.</td>
</tr>
<tr>
<td>Add SQL Scripts</td>
<td>Add SQL scripts for each database that you expect to be used with the domains created from this template and specify the order in which the scripts are executed.</td>
</tr>
<tr>
<td>Configure the Administration Server</td>
<td>Define parameters for the Administration Server, a designated server from which the domain is managed.</td>
</tr>
<tr>
<td>Configure an Administrator Username and Password</td>
<td>Specify a user name and password to be used for starting the Administration Server. Optionally, you can also configure additional security features by defining users and groups and assigning them to global security roles.</td>
</tr>
<tr>
<td>Specify Start Menu Entries</td>
<td>Optionally, define entries for the Windows Start Menu.</td>
</tr>
<tr>
<td>Prepare Scripts and Files with Replacement Variables</td>
<td>Replace specific paths, filenames, and other domain environment settings with replacement variables in text files contained in the template. The Configuration Wizard later replaces the variables with exact strings to set up a specific WebLogic domain.</td>
</tr>
<tr>
<td>Review the Domain Template</td>
<td>Review the settings defined in your template.</td>
</tr>
<tr>
<td>Create Your Domain Template</td>
<td>Specify the name and directory for the domain template, and launch the process that creates it.</td>
</tr>
</tbody>
</table>
Overview of Creating Extension Templates Using the Domain Template Builder

The process used to create an extension template is virtually the same as the process used to create a domain template except that you are not prompted to configure the Administration Server, assign an administrator username and password, or specify Start menu entries, since these domain settings are defined in the domain to be extended.

To create an extension template using the Domain Template Builder, you select a domain or extension template to use as the basis for your template which you can then modify to suit your needs. When creating an extension template, you have the option of modifying the following:

- Basic template information, such as name and description
- Application directory contents and location
- Files to be included in the template
- SQL scripts for database configuration
- Additional security, such as creating users, groups, and global roles
- Customized scripts and variables

The Domain Template Builder creates an extension template (JAR file) that can be used to extend an existing domain. Table 1-2 summarizes the steps for creating an extension template using the Domain Template Builder.

<table>
<thead>
<tr>
<th>In this step</th>
<th>You...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a New Extension Template</td>
<td>Choose <strong>Create an Extension Template</strong> to create a new extension template.</td>
</tr>
<tr>
<td>Select a Template Domain Source for Your Extension Template</td>
<td>Choose an extension template or a domain directory from which you want to create a domain template.</td>
</tr>
<tr>
<td>Describe Your Extension Template</td>
<td>Enter a description of the template. If you selected an existing template as your source, the description for that template is displayed. Review and modify the description if necessary.</td>
</tr>
<tr>
<td>Add or Omit Applications in Your Extension Template</td>
<td>Review and modify, if desired, the list of applications to be included in your extension template.</td>
</tr>
</tbody>
</table>
### Table 1-2 Steps for Creating Extension Templates Using the Domain Template Builder (Continued)

<table>
<thead>
<tr>
<th>In this step</th>
<th>You . . .</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Files to Your Extension Template</td>
<td>Review and modify, if desired, the list of files to be included in your extension template.</td>
</tr>
<tr>
<td>Add SQL Scripts to Your Extension Template</td>
<td>Add SQL scripts for each database that you expect to be used with the domains created from this template and specify the order in which the scripts are executed.</td>
</tr>
<tr>
<td>Configuring Security Options in Your Extension Template</td>
<td>Optionally, create users, groups, and roles, then assign them to groups and global roles.</td>
</tr>
<tr>
<td>Prepare Scripts and Files When Creating Extension Templates</td>
<td>Replace specific paths, filenames, and other environment-specific strings with replacement variables in text files contained in the template. Later, when a specific WebLogic domain is being created, the Configuration Wizard replaces these variables with exact strings.</td>
</tr>
<tr>
<td>Review the Extension Template Settings</td>
<td>Review the settings defined in your templates.</td>
</tr>
<tr>
<td>Create Your Extension Template</td>
<td>Enter a name and directory for the extension template, and launch the process that creates it.</td>
</tr>
</tbody>
</table>
Additional Tools for Creating Templates and Domains

Your product installation includes several tools for creating templates and domains: the Domain Template Builder, the `pack` and `unpack` commands, WLST Offline, and the Configuration Wizard. As described previously, you can use the Domain Template Builder to create custom domain and extension templates using a graphical user interface. The other tools are described in the following table.

<table>
<thead>
<tr>
<th>Task</th>
<th>Tools Used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a template</td>
<td>pack—command that enables you to create a template archive (.jar) file that contains a snapshot of either an entire domain or a subset of a domain. You can use a template that contains a subset of a domain to create a Managed Server domain directory hierarchy on a remote machine. For more information, see Creating Templates and Domains Using the pack and unpack Commands at the following URL: <a href="http://e-docs.bea.com/common/docs90/pack/index.html">http://e-docs.bea.com/common/docs90/pack/index.html</a></td>
</tr>
<tr>
<td></td>
<td>WLST Offline—command-line scripting interface used to create a new domain or update an existing domain without connecting to a running instance of WebLogic Server. The <code>writeTemplate</code> functionality of WLST Offline provides the same capability for creating a template as the <code>pack</code> command. For more information, see “Creating a Domain Template (Offline)” in “Creating and Configuring WebLogic Domains Using WLST Offline” in <em>WebLogic Scripting Tool</em> at the following URL: <a href="http://e-docs.bea.com/wls/docs90/config_scripting/domains.html#create_template">http://e-docs.bea.com/wls/docs90/config_scripting/domains.html#create_template</a></td>
</tr>
</tbody>
</table>
Table 1-3 Additional Tools for Creating Templates and Domains (Continued)

<table>
<thead>
<tr>
<th>To perform the following task</th>
<th>Use the following tools</th>
</tr>
</thead>
</table>
| Create a new domain or extend an existing domain | • Configuration Wizard—stand-alone Java application that guides you through the process of creating or extending a domain. When creating a domain, you can choose to accept the default settings or to customize the domain to more closely match your particular environment. To customize your domain, you can add and configure Managed Servers, clusters, and machine definitions, and/or customize predefined JDBC data sources and JMS file store directories. You can also use the Configuration Wizard to extend an existing domain by adding predefined applications and services, or product component functionality. For more information, see *Creating WebLogic Domains Using the Configuration Wizard* at the following URL: [http://e-docs.bea.com/common/docs90/configwiz/index.html](http://e-docs.bea.com/common/docs90/configwiz/index.html)  
  • WLST Offline—command-line scripting interface used to create a new domain or update an existing domain without connecting to a running instance of WebLogic Server. WLST Offline supports the same functionality as the Configuration Wizard. For more information, see *WebLogic Scripting Tool* at the following URL: [http://e-docs.bea.com/wls/docs90/config_scripting/index.html](http://e-docs.bea.com/wls/docs90/config_scripting/index.html)  
  • unpack—command that enables you to create a new domain by using a template compatible with your current installation. To create a Managed Server domain, use the unpack command with a Managed Server template. You cannot use unpack to extend an existing domain. For more information, see *Creating Domains and Templates Using the pack and unpack Commands* at the following URL: [http://e-docs.bea.com/common/docs90/pack/index.html](http://e-docs.bea.com/common/docs90/pack/index.html) |
Starting the WebLogic Domain Template Builder

This section describes how to invoke the WebLogic Domain Template Builder. The Domain Template Builder can be invoked only in graphical mode. If you prefer to work in a non-graphical mode, you can create templates from the command line using the `pack` and `unpack` commands. For more information, see Creating Domains and Templates Using the pack and unpack Commands at the following URL:

http://e-docs.bea.com/common/docs90/pack/index.html

Topics include:

- Starting the Domain Template Builder on Windows Platforms
- Starting the Domain Template Builder on UNIX Platforms

Starting the Domain Template Builder on Windows Platforms

To start the Domain Template Builder on a Windows platform, do one of the following:

- From the Start Menu, choose:
  
  Start→Programs→BEA Products→Tools→Domain Template Builder

- From a command prompt window:

  a. Go to the \common\bin subdirectory of the product installation directory. For example:

  cd c:\bea\weblogic90\common\bin
Starting the WebLogic Domain Template Builder

b. Enter the following command:

```
config_builder.cmd
```

## Starting the Domain Template Builder on UNIX Platforms

**Note:** In graphical mode, the console attached to the machine on which you are running the Domain Template Builder must support a Java-based GUI.

1. Log in to the target system.
2. Open a command shell.
3. Go to the `common/bin` subdirectory of the product installation directory. For example:

```
cd BEA_HOME/weblogic90/common/bin
```
4. Invoke the following script:

```
sh config_builder.sh
```
Creating Domain Templates Using the Domain Template Builder

The following topics describe each step required to create a new domain template:

- Create a New Template
- Select a Template Domain Source
- Describe the Template
- Add or Omit Applications
- Add Files
- Add SQL Scripts
- Configure the Administration Server
- Configure an Administrator Username and Password
- Configure Users, Groups, and Global Roles
- Specify Start Menu Entries
- Prepare Scripts and Files with Replacement Variables
- Review the Domain Template
- Create Your Domain Template
Create a New Template

The **Create a New Template** window prompts you to choose the type of template you want to create: a domain template or an extension template.

<table>
<thead>
<tr>
<th>Choose this option</th>
<th>When you want to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a Domain Template</td>
<td>Create a template that defines the full set of resources within a domain, including infrastructure components, applications, services, security options, and general environment and operating system parameters. You can then use this template as input to the Configuration Wizard, WLST Offline, or the <code>unpack</code> command to create a new domain.</td>
</tr>
<tr>
<td>Create an Extension Template</td>
<td>Create a template that defines applications and services that can be used to extend an existing domain. The applications and services stored in the selected extension templates are imported into an existing domain using the Configuration Wizard. To learn more about creating an extension template, see Chapter 4, “Creating Extension Templates Using the Domain Template Builder.”</td>
</tr>
</tbody>
</table>

Select a Template Domain Source

The **Select a Template Domain Source** window prompts you to choose the domain or domain template from which you want to create a domain template.

**To choose a domain as the source for your template:**

1. Select the **Select a Domain** tab.
2. Navigate to the directory of the domain from which you want to create a domain template. Valid domain directories are indicated by a 🗄️ icon.
3. Click **Next** to proceed to the next configuration window.

   The Domain Template Builder verifies that the directory you selected contains a valid domain. If it does not, an error message is displayed.
To choose a domain template as the source for your template:

1. Select the Select a Template tab.

2. Review the list of templates displayed in the Templates pane. The templates displayed for selection reside in the directory specified in the Locate Additional Templates field. If you need to select an alternate directory:
   a. Click Browse to invoke a dialog box called Select a Template Directory.
   b. In the dialog box, navigate to the appropriate directory or manually enter its pathname in the Location field.
   c. Click OK to return to the Select a Template Domain Source window.

A list of the domain templates available in the selected directory is displayed in the Templates pane. Templates are organized by category. For example, the predefined domain templates provided with your product installation are listed together under the heading BEA.

3. Select a domain template from the list.

4. Click Next to proceed to the next configuration window.

Describe the Template

The Describe the Template window prompts you to provide a description that will be displayed in the Select a Template area of the Select a Template Domain Source window.

To enter template description information:

1. Do one of the following:
   - If you selected a domain directory in the previous window, enter the information required for your domain, as described in the following table, and click Next.
   - If you selected a template in the previous window, the information from the selected template is displayed here. Review the information, and modify it, if necessary, to meet the requirements of your domain, as described in the following table. Then click Next.
Creating Domain Templates Using the Domain Template Builder

Add or Omit Applications

**Note:** The Add or Omit Applications window is displayed if applications are included in the template or domain selected in “Select a Template Domain Source” on page 3-2.

The Add or Omit Applications window allows you to:

- Review the list of applications that are currently defined in your template source
- Review the pathnames of the current and imported applications
- If necessary, change the relative path for the directory into which applications are imported
- If necessary, omit applications from the list of files to be imported

By default, the Domain Template Builder includes applications from the domain or template you specified as the source for the template you are creating. For example:
Add or Omit Applications

- If you selected an existing template as the source for your new template and the source template has a separately defined applications directory, all the application files defined in the applications directory are included by default.

- If you selected a domain as the source for your new template, any application files defined in the config.xml file using the app-deployment element are included by default.

Note: If you create a template that contains applications with application-scoped JDBC and/or JMS resources, and subsequently use the template as input to the Configuration Wizard or WLST Offline to create or extend a clustered domain, you may need to perform additional steps (after the domain is created or extended) to make sure that the application and its application-scoped resources are targeted and deployed properly in a clustered environment. For more information on the targeting and deployment of application-scoped modules, see “Deploying Applications and Modules” in Deploying Applications to WebLogic Server at the following URL: http://e-docs.bea.com/wls/docs90/deployment/deploy.html

To add or omit applications in the template:

1. In the Applications pane, review the list of applications to be included in your template. By default, all applications are checked, indicating that they will be included.

   The applications displayed reside in the directory specified in the Current Application Path field. The applications are copied into your template from this location.

2. To change the relative path of the directory into which an application will be imported, do the following:
   a. Select the application in the Applications pane.
   b. In the Imported Application Path field, enter the relative path you want to use after the application is imported into your template.

   Note: Some of the applications listed in the Applications pane may be provided with your WebLogic software. You cannot change the relative paths for these applications. When you select these applications in the Applications pane, the Imported Application Path field is replaced by an Internal Application Path. Because these files are installed on your system during your product installation, they are not copied into the template at template creation time. When you create a domain using this template, this path will point to the application files contained in your product installation directory.

3. Clear the check box for any application that you do not want to include in the template.

4. Click Next to proceed to the next configuration window.
Add Files

By default, the Domain Template Builder includes files from the domain or template you specified as the source for the template you are creating. For example:

- If you selected an existing template as the source for your new template, all files from the source template are automatically included. If the existing template defines a separate applications directory, the applications in the template are listed under the **Applications Root Directory** in the **Current Template View** pane.

- If you selected a domain as the source for your new template, the following files and directories are included by default:
  - All files in the root directory with the following extensions: `.cmd`, `.sh`, `.xml`, `.properties`, and `.ini`.
  - Any files with the `.pem` extension defined in the SSL configuration for your domain.
  - `bin` directory
  - `lib` directory
  - All files in the `security` directory that are not created by the Template Builder automatically during template creation. For example, `DefaultAuthenticatorInit.ldift` and `DefaultRoleMapperInit.ldift` are not included by default.
  - All files and subdirectories in the `config` directory that are not created by the Template Builder automatically during template creation. For example, `config.xml` and any JDBC and JMS resources defined in `config.xml` are not included by default.

**Note:** The `servers` directory is not included in the template by default. If you have configured additional security data such as users, groups, or roles, through the WebLogic Server Administration Console or other online tools, it has been stored in the LDAP server and will not be included in the template. You will need to export the data first and then import it into the target domain.

You may also need to include other files from your domain or file system that are required by the applications.

The **Add Files** window prompts you to review, add, or remove files in the template.
To add files into the template you are creating:

1. To view the current list of files in your template, expand the Domain Root Directory and Applications Root Directory in the Current Template View pane.

2. To add or remove files, perform the following steps:
   - To add a file, navigate to the file within the File System View pane and select Add File. You can limit the files displayed in this pane by using the filters available in the Show File Types drop-down list. For example, to display only files with the .cmd extension, select *.cmd from the drop-down list.
   - To remove a file, select the file that you want to delete from the Current Template View pane, and select Remove File.

Notes:

You cannot remove files shown in red or their parent directories as they comprise the applications defined in the config.xml file in the template source. These files will be included by default in the template being created. If you do not want these files included in your template, you must remove the application with which they are associated. To do so, click Previous to return to the Add or Omit Applications window and clear the appropriate check box for the application.

If you attempt to add a file that is created automatically by the Configuration Wizard at domain creation time, an error message is displayed.

3. Repeat steps 1 and 2 for each file that you want to add or remove.

4. Click Next to proceed to the next configuration window.

Add SQL Scripts

Adding SQL scripts to your template is optional. The Add SQL Scripts window prompts you to add SQL scripts for each database that you expect to be used with the domains created from this template. You can also specify the order in which the scripts are executed. When you create a domain using this template, the databases and associated SQL scripts that you include are displayed in the Run Database Scripts window of the Configuration Wizard.

Note: If you are using a template as your template source, any SQL files that are included in the template source are displayed in the Selected Database Scripts pane, organized by database type. If desired, you can remove specified SQL scripts. For instructions, see “To remove SQL scripts from your template:” on page 3-8.
To add SQL scripts to your template:

1. In the Database Type and Version pane, select a database from the Type drop-down list.
2. Select the database version from the Version drop-down list or enter a version number directly in the field.
3. Click Add SQL File.
   The Add SQL File(s) dialog box is displayed.
4. In the Add SQL File(s) dialog box, navigate to the directory that contains the SQL scripts for the selected database.
5. Select the SQL files to be added.
6. Click Add SQL File(s).
   The SQL files that you added are displayed in the Selected SQL Files list and the Selected Database Scripts pane of the Add SQL Scripts window. The Selected Database Scripts pane displays a tree-view of all the databases and associated SQL scripts included in the template.
7. To specify the order in which SQL files are executed, select a file from the Selected SQL Files list and use the up and down arrows to change the order of the files in the list.
   The specified sequence is reflected in the Selected Database Scripts pane. When you create a domain based on this template, this information is displayed in the Run Database Scripts window of the Configuration Wizard.
8. Repeat steps 1 through 7 for each database for which you want to include SQL files.
9. Click Next to proceed to the next configuration window.

To remove SQL scripts from your template:

1. From the Type drop-down list in the Database Type and Version pane, select the database from which you want to remove SQL scripts.
2. Select the database version from the Version drop-down list or enter a version number directly in the field.
   The SQL scripts for the selected database displayed in the Selected Database Scripts pane are listed in the Selected SQL Files pane.
3. In the Selected SQL Files pane, select the SQL file to be removed and click Remove SQL File.
4. Repeat steps 1 through 3 for each database for which you want to remove SQL files.

5. Click Next to proceed to the next configuration window.

   **Note:** If you are creating an extension template, the next configuration window displayed is Security Configuration Options. For more information, see “Configuring Security Options in Your Extension Template” on page 4-5.

### Configure the Administration Server

In every domain, one server must be designated the Administration server: the central point from which the whole domain is managed. The *Configure the Administration Server* window prompts you to define configuration information for the Administration Server. This information is used to access the Administration Server in the domain.

Servers can be reached using the following URL:

```
protocol://listen-address:listen-port
```

In this URL, *protocol* can be any of the following:

- t3
- t3s
- http
- https

*listen-address* and *listen-port* are defined in the *Configure the Administration Server* window.
To configure the Administration Server:

Review the values displayed in the window and modify them as necessary, using the guidelines provided in the following table. When you finish updating your settings, click Next.

<table>
<thead>
<tr>
<th>In this field . . .</th>
<th>Do the following . . .</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong>*</td>
<td>Enter a valid server name: a string of characters that can include spaces. Each server instance in your product environment must have a unique name, regardless of the domain or cluster in which it resides, and regardless of whether it is an Administration Server or a Managed Server. In addition, the name of the Administration Server must be unique among all component names within the domain. <strong>Note:</strong> This value is specified for identification purposes only; it is not used as part of the URL for applications that are deployed on the server. The server name is displayed in the WebLogic Server Administration Console. In addition, if you use WebLogic Server command-line utilities or APIs, you must specify this name to identify the server.</td>
</tr>
</tbody>
</table>
| **Listen address**  | From the drop-down list, select a value for the listen address. Valid values for the listen address are as follows:  
  • All Local Addresses (default)  
  • IP address of the computer that hosts the server  
  • DNS name that resolves to the host  
  • localhost (valid only for requests that are issued from the computer on which the server is running)  
If you identify the listen address for a server instance as localhost, non-local processes cannot connect to the server instance. Only processes on the machine that hosts the server instance can connect to the server instance. If the server instance must be accessible as localhost (for example, if you create administrative scripts that connect to localhost), and it must also be accessible by remote processes, select All Local Addresses. The server instance determines the address of the machine and listens on it.  
To learn more about Listen Addresses, see “Specifying Listen Addresses” on page 3-12. |
### Configure the Administration Server

#### Creating Templates Using the Domain Template Builder

<table>
<thead>
<tr>
<th>In this field</th>
<th>Do the following</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Listen port</strong></td>
<td>Enter a valid value for the listen port to be used for regular, non-secure requests (via protocols such as HTTP and T3). The default value is 7001. If you leave this field blank, the default value is used. Any number between 1 and 65535 is a valid value. For more information, see “Specifying Listen Ports” on page 3-13.</td>
</tr>
<tr>
<td><strong>SSL listen port</strong></td>
<td>Enter a valid value to be used for secure requests (via protocols such as HTTPS and T3S). The default value is 7002. If you leave this field blank, the default value is used. Any number between 1 and 65535 is a valid value. <strong>Note:</strong> By default, a server instance uses demonstration certificates to authenticate requests from a secure port. In a production environment, you must configure SSL to use certificates from a certificate authority. For more information, see “Configuring SSL” in Securing WebLogic Server at <a href="http://e-docs.bea.com/wls/docs90/secmanage/ssl.html">http://e-docs.bea.com/wls/docs90/secmanage/ssl.html</a>. For more information, see “Specifying Listen Ports” on page 3-13.</td>
</tr>
<tr>
<td><strong>SSL enabled</strong></td>
<td>Select the check box in this field to enable the SSL listen port. By default, the SSL is disabled for all new servers.</td>
</tr>
</tbody>
</table>
Specifying Listen Addresses

If you want to limit the valid listen address for a server, use the guidelines for specifying listen addresses provided in the following table.

<table>
<thead>
<tr>
<th>If the listen address is set to . . .</th>
<th>Then the following is true . . .</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Local Addresses or DNS name</td>
<td>On multi-homed Windows machines, a server instance binds to all available IP addresses.</td>
</tr>
</tbody>
</table>
| IP Address or DNS name              | • To connect to the server instance, processes can specify either the IP address or the corresponding DNS name.  
• Processes that specify localhost fail to connect.  
• You must update existing processes that use localhost to connect to the server instance.  
• For connections that specify the IP address for the listen address and a secured port for the listen port, host name verification must be disabled. |

**Note:** To resolve a DNS name to an IP address, WebLogic Server must be able to contact an appropriate DNS server or obtain the IP address mapping locally. Therefore, if you specify a DNS name for the listen address, you must either leave a port open long enough for the WebLogic Server instance to connect to a DNS server and cache its mapping or you must specify the IP address mapping in a local file. If you specify an IP address for the listen address and then a client request specifies a DNS name, WebLogic Server will attempt to resolve the DNS name, but if it cannot access DNS name mapping, the request will fail.

| localhost                                 | • Processes must specify localhost to connect to the server instance.  
• Only processes that reside on the machine that hosts the server instance (local processes) will be able to connect to the server instance. |
Specifying Listen Ports

Refer to the following guidelines when specifying listen ports and secure listen ports:

- Although you can specify any valid port number, if you specify port 80, you can omit the port number from the HTTP request used to access resources over HTTP. For example, if you define port 80 as the listen port, you can use the URL `http://hostname/myfile.html` instead of `http://hostname:portnumber/myfile.html`.

- On some operating systems, port 80 can be accessed only by processes run under a privileged user or group ID. In this case, you can assign the server instance to a UNIX machine on which a Post-Bind UID or GID is defined.

- In a development environment, you might want to run multiple instances of WebLogic Server on a single computer. If you do so, each instance must use a unique listen port/listen address combination. On a multi-homed computer, you can use the same listen port but you must configure each server to use a unique IP address as its listen address. If your computer does not support multiple IP addresses, you must use a different listen port for each active instance.

Configure an Administrator Username and Password

When you create a domain template, the administrator username and password from the original domain or template are included in your new template. You can modify this username and password if desired. In addition, you can provide extra security for application resources using the following security features:

- Users and groups—Classification of individuals and collections of individuals who may be granted a security role. Typically, a group is a collection of users who share a role or function within a company, such as working in the same department.

- Global security roles—Dynamically computed privileges that are used to restrict access to WebLogic resources. These privileges are granted to or withheld from users according to which roles they are assigned.

To modify the administrator username and password:

1. Specify a valid username in the Username field by clicking within the field and modifying the string displayed there. This name is used to boot the Administration Server and connect to it.
Do not use commas, tabs, or any characters in the following comma-separated list: <, >, #, |, &, ?, { }, }. User names are case sensitive.

2. Specify a valid password in the User password field by clicking within the field and modifying the string displayed there. A valid password must contain at least 8 case-sensitive characters. The password value is encrypted.

   Note: Do not use the name/password combination weblogic/weblogic in a production environment.

3. Reenter the password in the Confirm user password field.

4. Optionally, enter a login description for this username.

5. If you want to configure additional users, groups, and global roles, select Yes at the bottom of the window.

6. Click Next to proceed to the next configuration window.

Configure Users, Groups, and Global Roles

The Configure Users, Groups and Global Roles window is displayed in the Domain Template Builder in the following circumstances:

- You are creating a domain template and you selected the option to configure users, groups, and global roles in the Configuring an Administrative Username and Password window.

- You are creating an extension template and you selected Yes in the Security Configurations Option window.

Users, groups, and global roles are defined as follows:

- A user is an entity that can be authenticated. It can be a person or a software entity, such as a Java client. Each user is given a unique identity within a security realm.

- A group is a collection of users who usually have something in common, such as working in the same department in a company.

- A security role is a privilege granted to users or groups based on specific conditions. Like groups, security roles allow you to restrict access to WebLogic resources for multiple users simultaneously. A security role that applies to all WebLogic resources deployed within a security realm (and, thus, within the entire WebLogic Server domain) is called a global role.
The **Configure Users, Groups and Global Roles** window prompts you to define users, groups, and roles for authentication purposes. You must define at least one user.

Depending on the template or domain selected, one or more users, groups, and/or roles may be defined already. In addition, WebLogic Server defines a default set of groups and roles. For a list of the default groups and roles defined in WebLogic Server, see “Users, Groups, and Security Roles” in *Securing WebLogic Resources* at the following URL:

http://e-docs.bea.com/wls/docs90/secwlres/secroles.html

**To configure users, groups, and global roles:**

1. Select the **User** tab and review the current list of user configurations. Add or modify entries as required by your domain, using the guidelines provided in the following table. To delete a user, click in one of its fields and click **Delete**.

<table>
<thead>
<tr>
<th>In this field . . .</th>
<th>Do the following . . .</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong></td>
<td>Fields marked with an asterisk are required.</td>
</tr>
<tr>
<td>User name*</td>
<td>Enter a valid username: a string of characters that are case sensitive. The space character is not supported.</td>
</tr>
<tr>
<td></td>
<td>The default value in this field is new_User_n, where n specifies a numeric value that is used to differentiate among all default user names; the value of n for the first user is 1. The value is incremented by 1 for each user that is added.</td>
</tr>
<tr>
<td>User password*</td>
<td>Enter a password for the user. A valid password is a string containing a minimum of 8 case-sensitive characters. The password value is encrypted.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Do not use the name/password combination weblogic/weblogic in a production environment</td>
</tr>
<tr>
<td>Confirm user password*</td>
<td>Reenter the password to confirm the value entered.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description of the user to be used for informational purposes only; for example, full name of user.</td>
</tr>
</tbody>
</table>

2. Select the **Group** tab and review the current list of group configurations. Add or modify the entries required by your domain, using the guidelines provided in the following table. To delete a group, click in one of its fields and click **Delete**. When you finish updating your settings, click **Next**.
Creating Domain Templates Using the Domain Template Builder

3. Select the **Role** tab and review the current list of role configurations. The predefined list of WebLogic Server global security roles is shown. Add or modify the entries required by your domain using the guidelines provided in the following table. To delete a role, click in one of its fields and click **Delete**. When you finish updating your settings, click **Next**.

**Warning:** Do not make the default global security roles for Administrative and Server resources more restrictive. If you eliminate any existing security roles, you risk degrading WebLogic Server operation. You can, however, make the default security roles more inclusive (for example, by adding new security roles).

### In this field . . . Do the following . . .

<table>
<thead>
<tr>
<th><strong>Note:</strong> Fields marked with an asterisk are required.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong>&lt;sup&gt;*&lt;/sup&gt;</td>
</tr>
<tr>
<td><strong>Description</strong></td>
</tr>
</tbody>
</table>

### Related Topics

“Users, Groups, and Security Roles” in *Securing WebLogic Resources* at the following URL:

http://e-docs.bea.com/wls/docs90/secwlres/secroles.html
Assign Users to Groups

The Assign Users to Groups window prompts you to assign users to groups. BEA recommends adding users to groups because by managing groups you can manage multiple users simultaneously.

To assign users to groups:

1. In the Group pane, select the group to which you want to assign users.
   The current assignments for the selected group are displayed in the left pane.

2. In the left pane, do one of the following:
   - To assign a user to the selected group, select the check box for the user.
   - To remove a user from the selected group, clear the check box for the user.
     To select all users in the list, choose Select All. To unselect all users in the list, choose Unselect All.
     The list of groups associated with each user is updated to reflect your changes.

3. Repeat steps 1 and 2 for each user that you want to assign to a group. You can assign a user to more than one group.

4. Click Next to proceed to the next configuration window.

Assign Groups to Groups

The Assign Groups to Groups window prompts you to designate one group as a subgroup of another group, as a means of refining the management of security for your domain.

Note: You should not assign groups recursively. For example, do not assign groupA as a subgroup of groupB and groupB as a subgroup of groupA. WebLogic Server does not support this type of recursion.

To assign groups to other groups:

1. In the Group pane, select the group to which you want to assign a subgroup.
   The current assignments for the selected group are displayed in the left pane.

2. In the left pane, do one of the following:
   - To assign a group, as a subgroup, to the selected group, select the check box for the group.
Creating Domain Templates Using the Domain Template Builder

- To remove a subgroup from the selected group, clear the check box for the group.

To select all groups in the list, choose Select All. To unselect all groups in the list, choose Unselect All.

The list of subgroups associated with each group is updated to reflect your changes.

3. Repeat steps 1 and 2 for each group that you want to designate a subgroup. You can make a group a subgroup of more than one group.

4. Click Next to proceed to the next configuration window.

Assign Users and Groups to Global Roles

The Assign Users and Groups to Global Roles window prompts you to assign users and groups to the global security roles defined by WebLogic Server. For a list of the default roles and the privileges that users or groups in these security roles are granted, see “Default Global Roles” in “Users, Groups, and Security Roles” in Securing WebLogic Server at http://e-docs.bea.com/wls/docs90/secwlres/secroles.html#default_roles.

Note: You must assign one or more users or groups (containing one or more users) to the Administrator role to ensure that there is at least one user who can boot WebLogic Server.

To assign users and groups to global security roles:

1. In the Role pane, select the global role to which you want to assign users and groups.
   The current assignments for the selected role are displayed in the left pane.

2. In the left pane, do one of the following:
   - To assign a user or group to the selected role, select the associated check box.
   - To remove a user or group from the selected role, clear the associated check box.

To select all users and groups in the list, choose Select All. To unselect all users and groups in the list, choose Unselect All.

The Role list corresponding to each user and group is updated to reflect the global roles to which the user and group are assigned.

3. Repeat steps 1 and 2 for each user or group that you want to assign to a global role. You can assign a user or group to more than one global role.

4. Click Next to proceed to the next configuration window.
Note: If you are creating an extension template, the next configuration window displayed is Prepare Scripts and Files with Replacement Variables. For more information, see “Prepare Scripts and Files with Replacement Variables” on page 3-20.

Related Topics


Specify Start Menu Entries

The Specify Start Menu Entries window prompts you to create items to be added to the Windows Start Menu. How you proceed depends on what you have chosen as the source for your custom template.

- If you selected a domain directory as the source for your custom template, Start Menu entries are not defined. To create Start Menu entries for your domain, enter the required information and click Next. The required information is defined in the following table.

- If you selected a template as the source for your custom template, the Start Menu entries from the selected template are displayed here. Review the information, and modify it, if necessary, to meet the requirements of your domain, as described in the following table.

To specify Start Menu entries:

Add, modify, or delete entries as required by your domain, using the guidelines provided in the following table. To delete an entry, click the tab for the Start Menu entry and click Delete. When you finish updating your settings, click Next.
Creating Domain Templates Using the Domain Template Builder

Prepare Scripts and Files with Replacement Variables

When you are creating a template, you want the scripts and files that you are packaging with your template to be free of local domain environment settings and ready for use by the Configuration Wizard. The Domain Template Builder automatically updates any standard scripts included in a template, such as start scripts, by replacing hard-coded values for various domain environment settings with replacement variables. The Configuration Wizard can later replace these variables with new hard-coded values during the configuration of a new domain.

<table>
<thead>
<tr>
<th>In this field . . .</th>
<th>Do the following . . .</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shortcut link name</td>
<td>Enter a valid name for the shortcut to be displayed in the Start menu. The name must be a string of characters and it may include the space character.</td>
</tr>
<tr>
<td>Program</td>
<td>Specify the program to be run when the shortcut is selected. A list of the programs defined by the template source is shown in the drop-down list. To use a predefined program, select it from the drop-down list. To specify an alternate program, enter the relative path to it in this field. To ensure that the template is portable, you can use variables such as $USER_INSTALL_DIR$ and $DOMAIN_DIRECTORY$ to specify your program path. For example: $USER_INSTALL_DIR$server\bin\installNodeMgrSvr.cmd. <strong>Note:</strong> Do not specify any executable or script that does not reside in your BEA Home directory.</td>
</tr>
<tr>
<td>Argument</td>
<td>Enter any parameter that you want to pass to the shortcut program.</td>
</tr>
<tr>
<td>Working Directory</td>
<td>Enter the pathname of the directory from which the shortcut will be executed. If you have selected a program from the drop-down list in the Program field, this field is not available. <strong>Note:</strong> By default, the working directory is the directory that contains the executable or script. In most cases, you do not need this field.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description for the shortcut.</td>
</tr>
</tbody>
</table>
The Prepare Scripts and Files with Replacement Variables window allows you to replace hard-coded strings with replacement variables in files that have not been updated by the Domain Template Builder.

**Note:** The check boxes of files that were automatically updated by the Domain Template Builder contain a check.

**To insert replacement variables into your files:**

1. Open the file in one of the following ways:
   - Double-click the appropriate filename in the Select File list
   - Select the appropriate filename in the list and click Edit

   The Instructions pane is replaced by an Edit File pane, in which the contents of the file are displayed. An editing toolbar is provided at the top of the window.

2. To insert a replacement variable:
   a. Select the string to be replaced.
   b. Click the right mouse button; a list of replacement variables is displayed.
   c. Select the desired variable.

   The replacement variable replaces the selected string. The Configuration Wizard later substitutes literal strings for the replacement variables to set up a specific WebLogic domain. For definitions of the available replacement variables, see “Replacement Variable Definitions” on page 3-22.

3. Repeat steps 1 and 2 for each string for which you want to substitute a variable.

4. Review your changes and click Save, to preserve your changes, or Revert, to replace the current version of the file with the last version saved. If you have edited the file since the last time you saved it, you are prompted to confirm the revert operation.

   **Note:** You can also click Reset within the Select File area to revert to the saved version of the file.

5. If you saved the edited file, select the check box next to the filename in the Select File pane.

6. Repeat steps 1 through 5 for each file in which you want to insert replacement variables.

7. Click Next to proceed to the next configuration window.
Replacement Variable Definitions

The following table defines the replacement variables most commonly used in files.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>BEAHOME</td>
<td>BEA Home directory in which the BEA products associated with the domain are installed. On a Windows system, the default pathname for this directory is <code>C:\bea</code>.</td>
</tr>
<tr>
<td>WL_HOME</td>
<td>Root directory of your WebLogic Server installation. By default, this directory is defined as <code>BEA_HOME\weblogic90</code>.</td>
</tr>
<tr>
<td>JAVA_HOME</td>
<td>Location of the JDK used to start WebLogic Server.</td>
</tr>
<tr>
<td>DOMAIN_NAME</td>
<td>Name of the domain.</td>
</tr>
<tr>
<td>DOMAIN_USER</td>
<td>Administration username required to start the server.</td>
</tr>
<tr>
<td>SERVER_NAME</td>
<td>Name of the server to be started.</td>
</tr>
<tr>
<td>SAMPLES_HOME</td>
<td>Directory containing the samples provided with your product installation. By default, the pathname for this directory is <code>BEA_HOME\weblogic90\samples</code>.</td>
</tr>
<tr>
<td>USERDOMAIN_HOME</td>
<td>Directory containing the user domains created with the Configuration Wizard. By default, the pathname for this directory is <code>BEA_HOME\user_projects\domains</code>.</td>
</tr>
<tr>
<td>STARTMODE</td>
<td>Mode in which the server is started: development or production.</td>
</tr>
<tr>
<td>PRODUCTION_MODE</td>
<td>Mode in which the server is started. If this variable is set to true, the server starts in production mode; if set to false, the server starts in development mode.</td>
</tr>
<tr>
<td>ADMIN_SERVER_URL</td>
<td>URL specifying the listen address (host name or IP address) and port number of the Administration Server for the domain.</td>
</tr>
<tr>
<td>JAVA_VM</td>
<td>Mode in which you want the JVM to run, such as <code>-jrockit</code>, <code>-server</code>, <code>-hotspot</code>.</td>
</tr>
<tr>
<td>JAVA_VENDOR</td>
<td>Vendor of the JVM, for example, BEA, HP, IBM, and Sun.</td>
</tr>
<tr>
<td>DOCSWEBROOT</td>
<td>The URL specifying the location of the product documentation on the BEA Web site.</td>
</tr>
</tbody>
</table>
Review the Domain Template

The Review WebLogic Domain Template window allows you to review a detailed specification for your domain template before you start creating it.

To review the domain template settings:

1. Select an item in the Template Summary pane on the left and review the associated details in the Details pane on the right. If you need to modify any information that you defined in previous windows, select Previous to return to the desired configuration window.

   **Note:** You can limit the type of information displayed in the Template Summary window by selecting a filter from the View drop-down list.

2. Click Next to proceed to the next configuration window.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>SERVER_HOST</td>
<td>Name or address of the machine hosting the server.</td>
</tr>
<tr>
<td>SERVER_PORT</td>
<td>Port to be used to listen for regular, non-secure requests (via protocols such as HTTP and T3). The default value is 7001.</td>
</tr>
<tr>
<td>DOMAIN_HOME</td>
<td>Directory in which the domain resides.</td>
</tr>
<tr>
<td>APPLICATIONS_DIRECTORY</td>
<td>Directory containing the applications required by the domain. By default, the pathname for this directory is BEA_HOME\user_projects\applications\domain.</td>
</tr>
<tr>
<td>LISTEN_PORT</td>
<td>Port to be used to listen for regular, non-secure requests (via protocols such as HTTP and T3). The default value is 7001.</td>
</tr>
<tr>
<td>SSL_PORT</td>
<td>Port to be used to listen for secure requests (via protocols such as HTTPS and T3S). The default value is 7002.</td>
</tr>
</tbody>
</table>
Create Your Domain Template

The Create a Template window prompts you to specify the name and directory for the domain template, and launch the process that creates it.

To create your domain template:

1. Specify a name for the template JAR file in the Template jar name field by clicking within the field and modifying the string displayed there.

2. Make sure that the Template location field contains the name of the directory in which you want the template to reside. If you need to change the value in this field:
   a. Click Browse.
   b. In the dialog box, navigate to the appropriate directory or manually enter the pathname for it in the Location field and click OK.

   The template directory can be located anywhere on your system. By default, it resides in BEA_HOME\user_templates, where BEA_HOME is the directory that contains the product installation (by default, this directory is c:\bea on Windows).

3. After you verify the information displayed in the window, click Create.

   The Creating Template window is opened to display status messages during the template creation process. The Domain Template Builder generates a JAR file that contains all the components required to generate a new domain, including the template settings that you provided.

4. Click Done in the Creating Template window.

Note: The files included in a template vary, depending on the domain or template on which the template is based. For example, if you specify any Start Menu entries using the Specify Start Menu Entries window, a startmenu.xml file that contains the specified entries is included in your template. When you create your domain using this template, Start Menu entries are created using the values specified in this file. For more information, see “Files Typically Included in a Template” in Domain Template Reference at the following URL:

   http://e-docs.bea.com/common/docs90/tempref/tempref.html
Creating Extension Templates Using the Domain Template Builder

The process used to create an extension template is virtually the same as the process used to create a domain template except that you are not prompted to configure the Administration Server, assign an Administrator username and password, or specify Start menu entries, because these domain settings are already defined in the domain to be extended.

The following topics describe the steps you use to create an extension template:

- Create a New Extension Template
- Select a Template Domain Source for Your Extension Template
- Describe Your Extension Template
- Add or Omit Applications in Your Extension Template
- Add Files to Your Extension Template
- Add SQL Scripts to Your Extension Template
- Configuring Security Options in Your Extension Template
- Prepare Scripts and Files When Creating Extension Templates
- Review the Extension Template Settings
- Create Your Extension Template
Create a New Extension Template

The Create a New Template window prompts you to choose the type of template you want to create: a domain template or an extension template. To create an extension template, choose Create an Extension Template.

<table>
<thead>
<tr>
<th>Choose this option</th>
<th>When you want to . . .</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a Domain Template</td>
<td>Create a template that defines the full set of resources within a domain, including infrastructure components, applications, services, security options, and general environment and operating system parameters. You can then use this template to create a new domain. To learn more about creating a domain template, see Chapter 3, “Creating Domain Templates Using the Domain Template Builder.”</td>
</tr>
<tr>
<td>Create an Extension Template</td>
<td>Create a template in which you define applications and services that can be used to extend an existing domain.</td>
</tr>
</tbody>
</table>

Select a Template Domain Source for Your Extension Template

The Select a Template Domain Source window prompts you to choose the application template or domain directory from which you want to create an extension template.

To select an extension template as your extension template source:

1. Select the Select a Template tab.

   A list of the extension templates available in the directory specified in the Locate Additional Templates field is displayed. Templates are organized by category. For example, the predefined extension templates provided with the product installation are listed together under the heading BEA.

   If you need to change directories:

   a. Click Browse to invoke the Select a Template Directory dialog box.

   b. In the dialog box, navigate to the appropriate directory or manually enter the pathname of the directory in the Location field and click OK.

2. Select an extension template from the list.

   Information about the selected template is displayed in the Description and Author fields.

3. Click Next to proceed to the next configuration window.
To select a domain as your extension template source:

1. Select the Select a Domain tab.
2. Navigate to the domain directory from which you want to create an extension template and select the desired domain.
   
   Valid domain directories are indicated by a 🗄️ icon.
3. Click Next to proceed to the next configuration window.

Describe Your Extension Template

The Describe the Template window prompts you to provide a description that will be displayed in the Select a Template area of the Select a Template Domain Source window.

To enter template description information, do one of the following:

- If you selected a template in the Select a Template Domain Source window, the information from the selected template is displayed here. Review the information and, if necessary, modify it to meet the needs of your extension template, as described in “Describe the Template” on page 3-3. Then click Next.

- If you selected a domain directory in the Select a Template Domain Source window, enter the information required for your extension template, as described in “Describe the Template” on page 3-3. Then click Next.

Add or Omit Applications in Your Extension Template

The Add or Omit Applications window prompts you to:

- Review the list of applications that are currently defined in your template source
- Review the pathnames of the current and imported applications
- If necessary, change the relative directory into which applications are imported
- If necessary, omit applications from the list of files to be imported

For more information, see “Add or Omit Applications” on page 3-4.
Add Files to Your Extension Template

By default, the Domain Template Builder includes files from the domain or extension template you specified as the source for the extension template you are creating. For example:

- If you select an existing extension template as the source for your new extension template, all files from the source template are automatically included. If the existing template has a separately defined applications directory, the applications contained in the template are listed under the **Applications Root Directory** in the **Current Template View** pane.

- If you select an existing domain as the source for your new extension template, the following files and directories are included by default:
  - All files in the root directory with the following extensions: .cmd, .sh, .xml, .properties, and .ini.
  - Any files with the .pem extension defined in the SSL configuration for your domain
  - bin directory
  - lib directory
  - All files in the **security** directory that are not created automatically by the Template Builder during template creation. For example, DefaultAuthenticatorInit.ldift and DefaultRoleMapperInit.ldift are not included by default because they are created by the Template Builder during template creation.
  - All files and subdirectories in the **config** directory that are not created automatically by the Template Builder during template creation. For example, config.xml and any JDBC and JMS resources defined in config.xml are not included by default because they are created by the Template Builder during template creation.

**Note:** The **servers** directory is *not* included in the template by default. If you have configured additional security data such as users, groups, or roles, through the WebLogic Server Administration Console or other online tools, it has been stored in the LDAP server and will not be included in the template. You will need to export the data first and then import it into the target domain.

You may also want to include other files from your system or network, as required by your application. The **Add Files** window prompts you to review, add, or remove files in the template.
Add SQL Scripts to Your Extension Template

To add files to the template you are creating:

1. To view a list of files that currently reside in your template, expand the Domain Root Directory and Applications Root Directory in the Current Template View pane.

2. To add or remove files, perform the following steps:
   - In the Current Template View, select the destination directory to which you want to add a file.
   - To add a file, navigate to the file within the File System View area and select *Add File*.
   - You can limit the files displayed in this view by selecting a filter from the Show File Types drop-down list. For example, to display only files with the .cmd extension, select *.cmd from the drop-down list.
   - To remove a file, select the file that you want to delete from the Current Template View pane, and select *Remove File*.

3. Repeat steps 1 and 2 for each file that you want to add or remove.

4. Click *Next* to proceed to the next configuration window.

**Add SQL Scripts to Your Extension Template**

The *Add SQL Scripts* window prompts you to add SQL scripts for each database that you expect to be used with the domains that you extend using this template. You can also specify the order in which the scripts should be executed. For more information, see “Add SQL Scripts” on page 3-7.

**Configuring Security Options in Your Extension Template**

Optionally, you can configure security parameters for your application—specifically, for the application resources within the domain. You can provide security for an application resource using the following security features:

- **Users and groups**—Classification of individuals and collections of individuals who may be granted a security role. Typically, a group is a collection of users who share a role or function within a company, such as working in the same department.

- **Global security roles**—Dynamically computed privileges that are used to restrict access to WebLogic resources. These privileges are granted to or withheld from users according to which roles they are assigned.
For example, to leverage individual skills, many Web development teams divide system administration responsibilities into distinct roles. A team may then assign a different level of permission to each role. Each project might give only one or two team members permission to deploy components, but allow all team members to view the WebLogic Server configuration.

WebLogic Server supports such role-based development by providing four default global roles that determine access privileges for system administration operations: Admin, Deployer, Operator, and Monitor.

**Warning:** Do not make the default global security roles for Administrative and Server resources more restrictive. If you eliminate any existing security roles, you risk degrading WebLogic Server operation. You can, however, make the default security roles more inclusive (for example, by adding new security roles).

The **Security Configuration Options** window prompts you to set security options for your application. If you choose **No**, the security settings in the extension template that is created match those defined in the template or domain on which it is based. If you choose **Yes**, you are prompted, in subsequent windows, to configure the security as described in the following table.

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure Users, Groups, and Global Roles</td>
<td>Define users, groups, and global roles for authentication purposes. For instructions, see “Configure Users, Groups, and Global Roles” on page 3-14.</td>
</tr>
<tr>
<td>Assign Users to Groups</td>
<td>Assign users to groups. Groups allow you to manage a number of users at the same time. This is generally more efficient than managing each user individually. For instructions, see “Assign Users to Groups” on page 3-17.</td>
</tr>
<tr>
<td>Assign Groups to Groups</td>
<td>Designate a group as a subgroup of another group, to add further granularity to security management. For instructions, see “Assign Groups to Groups” on page 3-17.</td>
</tr>
<tr>
<td>Assign Users and Groups to Global Roles</td>
<td>Assign users and groups to predefined WebLogic Server global security roles. For instructions, see “Assign Users and Groups to Global Roles” on page 3-18.</td>
</tr>
</tbody>
</table>
Prepare Scripts and Files When Creating Extension Templates

The Domain Template Builder automatically updates any standard scripts included in a template, such as start scripts, by replacing hard-coded values for various domain environment settings with variables. The Configuration Wizard can later replace these variables with new hard-coded values during the configuration of a new domain.

If you like, you can prepare additional files that are included with your template by manually inserting replacement variables. For more information, see “Prepare Scripts and Files with Replacement Variables” on page 3-20.

Review the Extension Template Settings

The Review WebLogic Domain Template window allows you to review the details for your extension template before you initiate its creation.

To review the extension template settings:

1. Select an item in the Domain Summary pane on the left and review the associated details in the Details pane on the right. If you need to modify any information, select Previous to return to the desired configuration window.

   Note: You can limit the type of information displayed in the Domain Summary window by selecting a filter from the View drop-down list.

2. Click Next to proceed to the next configuration window.

Create Your Extension Template

The Create an Extension Template window prompts you to specify the name and directory for the extension template, and launch the process that creates it.

To create your extension template:

1. Specify a name for the template JAR file in the Template Jar Name field by clicking within the field and modifying the string displayed there.

2. Make sure that the Template Location field contains the name of the directory in which you want the extension template to reside. If you need to change the value in this field:
   a. Click Browse to invoke the Select the Template Creation Directory dialog box.
   b. In the dialog box, navigate to the appropriate directory or manually enter the pathname for it in the Location field and click OK.
The template directory can be located anywhere on your system. By default, it resides in $BEA_HOME\user_templates$, where $BEA_HOME$ is the directory that contains the product installation (by default, this directory is $c:\bea$ on Windows).

3. Click **Create**.

   The **Creating Template** window is opened to display status messages during the template creation process. The Domain Template Builder generates a JAR file that contains only the applications and services specified in the extension template.

4. Click **Done** in the **Creating Template** window.
How Do I . . . ?

This section provides information and examples for some common template creation tasks:

- How Do I: Create a Custom Domain Template?
- How Do I: Create a Custom Extension Template?

**How Do I: Create a Custom Domain Template?**

The following example explains how to create a custom domain template using the Avitek Medical Records Sample Domain. A domain template defines the full set of resources within a domain, including infrastructure components, applications, services, security options, and general environment and operating system parameters. Once you have created this sample domain, you can then use this template as input to the Configuration Wizard to create a new Medical Records sample domain.

**Note:** This example is based on the assumption that you installed the WebLogic Server samples during your product installation. For information about installing the samples, see the *Installation Guide* at the following URL:

http://e-docs.bea.com/common/docs90/install/index.html

1. Start the Domain Template Builder.
   - On Windows:
     - `Start→Programs→BEA Products→Tools→Domain Template Builder`
– On UNIX:
  Go to the /common/bin subdirectory of the product installation directory. For example:
  cd $BEAHOME/weblogic90/common/bin
  Enter sh config_builder.sh

2. In the Create a New Template window, select Create a Domain Template and click Next.

3. In the Select a Template Domain Source window, do the following:
   a. Click the Select a Domain tab if it is not already selected.
   b. Go to the following directory:
      WL_HOME\samples\domains
      In this pathname, WL_HOME represents the directory in which you installed your WebLogic software, typically C:\bea\weblogic90.
   c. Select the medrec domain.
   d. Click Next.

4. In the Describe the Template window, enter a descriptive name for your template. If the template you are creating will be used as the source for a new template, the information you provide in this window will be displayed in the Select a Template area of the Select a Template Domain Source window.
   For this example, enter the following information and click Next.
   Name: Avitek Medical Records Sample Domain
   Author: BEA Systems, Inc
   Category: BEA
   Description: Create the Avitek Medical Records domain in a directory outside of the installed kit. The Avitek Medical Records is a WebLogic Server sample application suite that concisely demonstrates all aspects of the J2EE platform.

5. In the Add or Omit Applications window, you have the option to omit applications from the template and, if applicable, change the relative path of the directory into which applications are imported. By default, all the applications contained in the domain are selected, indicating that they will be added to the template.
Since the applications in this domain were included with your WebLogic software, you cannot change the relative path of the directory into which they are imported. Because these applications already reside on your system, they are not copied into the template.

For this example, leave all applications selected and click **Next**.

6. In the **Add Files** window, you can add or remove files from the template. By default, the following files and directories are included in your template:

   - All files in the root directory with the following extensions: .cmd, .sh, .xml, .properties, and .ini.
   - bin directory
   - lib directory
   - All files in the security directory that are not created automatically by the Template Builder during template creation. For example, DefaultAuthenticatorInit.ldift and DefaultRoleMapperInit.ldift are not included by default.
   - All files and subdirectories in the config directory that are not created automatically by the Template Builder during template creation. For example, config.xml and any JDBC and JMS resources defined in config.xml are not included by default.

**Note:** Because the applications to be included in this template are provided with your product installation, they will not be copied into the template. Therefore, they are not listed under **Applications Root Directory** in the **Current Template View** pane.

If other files exist on your system that are needed by deployed applications, you can add them using this window.

For this example, we need to add a patient data file that is not included by default. To add the required file, do the following:

a. In the **File System View** pane, select the following directory: medrec\incoming

b. In the **Current Template View** pane, select **Domain Root Directory**.

c. Click **Add File**.

   The directory is added under the **Domain Root Directory**.

d. Click **Next** to proceed to the **Add SQL Scripts** window.
7. In the Add SQL Scripts window, you have the option to add SQL scripts for each database that you expect to use with the domains created from this template.

Because the Medical Records sample uses the default PointBase demo database included with your product installation, you do not need to add SQL scripts in this example.

However, you may want to use the Medical Records sample with other databases, such as Oracle or MySQL. To do so, you need to add the appropriate database scripts, as follows:

a. In the Database Type and Version pane, select Oracle from the Type drop-down list, and Any from the Version drop-down list.

b. Click Add SQL File.

c. In the Add SQL File(s) dialog box, navigate to the following directory:

   ```
   WL_HOME\samples\server\medrec\setup\db
   ```

   In this pathname, `WL_HOME` represents the directory in which you installed WebLogic Server, typically `C:\bea\weblogic90`.

d. From the Type drop-down list, select All Files.

e. Shift-click to select the following two files:

   ```
   medrec_oracle.dll
   medrec_oracle_data.sql
   ```

f. Click Add SQL File(s).

   The names of the files that you added are displayed in the Selected SQL Files list and the Selected Database Scripts pane.

To add database files for MySQL, complete the following procedure.

a. In the Database Type and Version pane, select MySQL from the Type drop-down list, and Any from the Version drop-down list.

b. Click Add SQL File.

c. In the Add SQL File(s) dialog box, navigate to the following directory:

   ```
   WL_HOME\samples\server\medrec\setup\db
   ```

d. From the Type drop-down list, select All Files.
e. Shift-click to select the following two files:
   medrec_mysql.dll
   medrec_mysql_data.sql

f. Click Add SQL File(s).
   The names of the files that you added are displayed in the Selected SQL Files list and
   the Selected Database Scripts pane.

Click Next.

8. In the Configure the Administration Server window, define the configuration information
   for the Administration Server, including:
   – Administration Server name
   – Listen address
   – Nonsecure and secure (optional) listen ports

   Servers can be reached through the following URL:
   protocol://listen-address:listen-port

   For more information, see “Configure the Administration Server” on page 3-9.

To configure the Administration Server in this example, leave the default values selected
and Click Next.

9. In the Configure Administrator Username and Password window, you can specify a
   valid username and password to be used to boot the Administration Server and connect to it.

   By default, the username/password combination for the Medical Records domain is
   weblogic/weblogic. You also have the option to configure additional users, groups, and
   global roles.

   For this example, accept the defaults defined and click Next.

10. In the Specify Start Menu Entries window, you can create entries for the Windows start
entry for the Medical Records server.

   To create the Start Menu entry to use to start the Medical Records server:
   a. Click Add.
   b. In the Shortcut link name field, enter Start Medical Records Server.
   c. From the Program field drop-down list, select bin/startWebLogic.cmd. It is not
      necessary to complete the remaining fields for this example.
To create the Start Menu entry to use to stop the Medical Records server:

a. Click Add.

b. In the Shortcut link name field, enter Stop Medical Records Server.

c. From the Program field drop-down list, select bin/stopWebLogic.cmd. It is not necessary to complete the remaining fields for this example.

d. Click Next.

11. In the Prepare Scripts and Files with Replacement Variables window, you can replace hard-coded strings with replacement variables in files that have not been updated by the Domain Template Builder. The Domain Template Builder automatically updates any standard scripts included in a template, such as start scripts, by replacing hard-coded values for various domain environment settings with replacement variables. The Configuration Wizard can later replace these variables with new hard-coded values during the configuration of a new domain.

In this example, it is not necessary to edit any additional scripts or files. Click Next to proceed to the Review WebLogic Domain Template window.

12. In the Review WebLogic Domain Template window, review the details for your domain template before you create it. If you need to make changes to any configuration information that you specified previously, click Previous to return to the desired configuration window.

Click Next to proceed to the Create a Template window.

13. In the Create a Template window, you enter a name for the template and specify a location for the template directory.

For this example, enter my_medrec_template in the Template jar name field.

By default, the template is created in BEA_HOME\user_templates, where BEA_HOME is the directory that contains the product installation. You do not need to change the default in this example.

Click Create.

14. In the Creating Template window, status messages are displayed during the template creation process. Click Done to close the Domain Template Builder.
How Do I: Create a Custom Extension Template?

The following example shows how to create a custom extension template by modifying the Avitek Medical Records Sample Domain extension template provided with your product installation. An extension template defines applications and services that can be used to extend an existing domain. The process used to create an extension template is virtually the same as the process used to create a domain template except that you are not prompted to configure the Administration Server, assign an Administrator username and password, or specify Start menu entries because these domain settings are already defined in the domain to be extended.

In this example, you create a customized MedRec extension template in which you will add support for an additional Medical Records user. Once you have created the sample extension template, you can extend an existing WebLogic domain with the Medical Records sample domain functionality by specifying your new extension template as input to the Configuration Wizard.

To create a customized MedRec extension template, complete the following procedure:

1. Start the Domain Template Builder.
   - On Windows:
     Start ➔ Programs ➔ BEA Products ➔ Tools ➔ Domain Template Builder
   - On UNIX:
     Go to the /common/bin subdirectory of the product installation directory. For example: cd $BEAHOME/weblogic90/common/bin
     Enter sh config_builder.sh

2. In the Create a New Template window, select Create an Extension Template and click Next.

3. In the Select a Template Domain Source window, select an existing extension template or a domain from which to create a new extension template. In this example, you will create an extension template using the Avitek Medical Records extension template provided with your product installation. To do so:
   a. Click the Select a Template tab if it is not already selected.
      A list of the predefined extension templates provided with your product installation is displayed in the Templates pane under the heading BEA.
   b. Select the Avitek Medical Records Sample Domain extension template from the list.
   c. Click Next.
4. In the **Describe the Template** window, enter a descriptive name for your extension template. Because you are using an existing template as the source for your custom template, the information from the Avitek Medical Records Sample Domain extension template is displayed here.

For this example, you do not need to modify the description.

Click **Next** to proceed to the **Add or Omit Applications** window.

5. In the **Add or Omit Applications** window, you have the option to omit applications from the extension template and change the relative path of the directory into which applications are imported. By default, all the applications included in the source are selected, indicating that they will be added to your custom template.

For this example, you do not need to add or omit any applications.

Click **Next**.

6. In the **Add Files** window, you can add or remove files from the extension template. Because you selected an existing template as the source for your custom template, all files from the source template are also included, automatically.

In this example, the Avitek Medical Records Sample Domain extension template includes a separately defined applications directory. Therefore the applications contained in the template are listed under **Applications Root Directory** in the **Current Template View** pane.

Click **Next** to proceed to the **Add SQL Scripts** window.

7. In the **Add SQL Scripts** window, you have the option to add SQL scripts for each database that you expect to use with the domains created from this template. Database scripts for PointBase, Oracle, and MySQL are included in the template by default.

For this example, you do not need to add any database scripts.

Click **Next**.

8. In the **Security Configurations Options** window, you have the option to customize any security settings that are already defined in either your domain or the extension template serving as the source for your extension template.

Because you are going to define an additional user in this example, select **Yes** and click **Next**.
9. In the **Configure Users, Groups, and Global Roles** window, you are prompted to define users, groups, and roles for authentication purposes. The users, groups, and roles defined in the template are listed. You can select the **Users**, **Groups**, and **Roles** tabs to view the current definitions.

In this example, you are going to define a new physician and assign the physician to an existing group. To do so:

a. Make sure the **Users** tab is selected.

b. Click **Add**.

c. Enter the following values:

   **User Name:** joe@md.com

   **User Password:** weblogic

   **Description:** MedRec Physician

By default, the new user is assigned to the **Administrators** group. In the next window you clear this assignment and assign joe@md.com to the **MedRec Physicians** group.

d. Click **Next**.

10. In the **Assign Users to Groups** window, you are prompted to assign users to groups. BEA recommends adding users to groups because by managing groups you can manage multiple users simultaneously.

In this example, you need to remove joe@md.com from the **Administrators** group and assign him to the group **MedRec Physicians**. To do so:

a. In the **Group** pane, make sure the **Administrators** group is selected.

   A list of current assignments for the **Administrators** group is displayed in the left pane.

b. In the left pane, clear the check box for joe@md.com.

c. In the **Group** pane, select the group **MedRec Physicians**.

   A list of current assignments for the **MedRec Physicians** group is displayed in the left pane.
d. In the left pane, select the check box for joe@md.com. The list of groups associated with joe@md.com is updated to reflect the change.

e. Click Next.

11. In the Assign Groups to Groups window, you can designate one group as a member of another group. In this example you do not need to change the default assignments. Click Next.

12. In the Assign Users and Groups to Global Roles window, you can assign users and groups to the global security roles defined by WebLogic Server. In this example you do not need to change the default assignments. Click Next.

13. In the Prepare Scripts and Files with Replacement Variables window, you can replace hard-coded strings with replacement variables in files that have not been updated by the Domain Template Builder. The Domain Template Builder automatically updates any standard scripts included in a template, such as start scripts, by replacing hard-coded values for various domain environment settings with replacement variables. The Configuration Wizard can later replace these variables with new hard-coded values during the configuration of a new domain.

In this example, it is not necessary to edit any additional scripts or files. Click Next to proceed to the Review WebLogic Domain Template window.

14. In the Review WebLogic Domain Template window, review the details for your extension template before you create it. If you need to modify any of the information that you defined previously, click Previous to return to the desired configuration window. Click Next.

15. In the Create an Extension Template window, enter a name for the extension template and specify a location for the template directory.

For this example, enter my_medrec_ext_template in the Template jar name field.

By default, the template is created in BEA_HOME\user_templates, where BEA_HOME is the directory that contains the product installation. You do not need to change the default in this example.

Click Create.

16. In the Creating Template window, status messages are displayed during the template creation process. Click Done.